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In addition to the individual program manuals, you will find basic explanations on the operation of the
programs on our homepage www.frilo.com » Support » Articles/Information » Basic operating
instructions.


https://www.frilo.eu/en/service/articles-information/basic-operating-instructions-frilo-software.html
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Application options

ST14 is an application program for the calculation of welded rigid steel frame joints in accordance with
DIN 18800, DIN EN 1993 and ONORM EN 1993.

Structural system
You can verify typical variants of T-joints and knee joints of double-T profiles:

- T-joint with haunch on one or both sides (joint bracing) and inclined beam

Knee joint with haunch on one side (joint bracing) and inclined beam
- Knee joint with welded tension plate in addition
- Knee joint with a bolted field joint as rigid end plate connection in flush or protruding version

In all variants, you can increase the bearing capacity of the shear field by applying transverse stiffeners
or a web plate on one side of the web. In addition, you can fit web ribs inside the column.

Loading (actions)

You have to enter the design values of the internal forces N, My and Vz. The internal forces must result
for the biggest part from dead loads.

Alternating moments can be included.

You can enter multiple combinations of actions via dedicated tables.

Calculation

Subject to verification are the weld seams, the shear fields as well as the transverse stiffeners or the
load application points and the field joint, if applicable.

The software proposes the required weld seam thickness values, if you activate the corresponding
option.

Output

You can document the results in a well-structured, abbreviated or extensive output with the help of a
customizable output profile. Optionally, you can generate a three- or two-dimensional graphic
representation of the structural system and include additional text notes in the output.

Limitations
The software assumes a braced connection with stiffeners in the column.

The field joint is proofed only under a load that generates tension in one chord and pressure in the
opposite chord.

If calculated according to DIN 18800, further restrictions arise for the field joint. According to the old
DSTV ring binder only S235 and bolts HV 10.9 are allowed. According to the new ring binder (2000), S355
and bolts HV 8.8 are also permitted, but the vertical rows of bolts are limited to two.

The proof of the welds follows the simplified procedure. The permissible threshold weld stresses are
used as the basis.
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Data entry

Definition of the structural system

First, select the appropriate joint among T-joint and knee joint in the Main menu or the corresponding
item in the Edit menu.

Note: A subsequent change of the connection involves the risk of data loss. The software takes over
all suitable parameter settings, but when changing from T to knee, for instance, the upper
joint bracing will be lost.

After this, define the geometry of the frame joint, its material and the internal forces. If you want to
calculate multiple combinations of internal forces in order to compare them, you can enter and handle
them via the list of internal forces (accessible via the Actions >> General dialog or the toolbar).

Material
Select the structural steel grade or define a material via the "Free definition" option.
material

lstructural sheel v] TO= 1.00

[s235 - [.]

To expand the list, click on ¥ or enter user-defined %= Material ==
values (free selection).
Yv  the default value of the partial safety factor Steel
of the resisting side yy is 1.1. You can set it
to 1.0 if Yy is included in the internal forces. Desicription 5235 |
ow  the oy factor of the permissible limit weld fyr = 2350 Nimm?®
seam stress as per DIN 18800 P. 1 is set to fi _ 3600 Nimm?
0.95 for S235 and to 0.8 for S355. For other '
steel grades, you must specify it manually. E-Modulus = 210000.0 Nimm?
G-Modulus = 2076592 N/mm#
Free selection oT = 00000120 1K
Select the "Free selection" option in the list of steel Bw = 080
grades and click subsequently on the E] button. W= 0.30
Enter a designation for the material and the . 7850 KNime

characteristic values for the modulus of elasticity
and the yield strength f,,

[ T —— ]

ok [ one
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Actions

The design values of the actions (subscript d) in the in the beam are entered in this section.

Knee joint  the internal forces can optionally be applied to the column in the variant "beam above

column".
loads (o] [ point A1
Hd= A0,00 kN [ ta the list ” general ]
Wad = 50,00 kM Myd= 100,00 kMm

Depending on the pre-condition, internal forces can be assigned to different reference points in the
frame joint.

Sign definition: see the chapter Actions - General.

Nd axial force transmitted in the direction of the defined centre line (depends on the
reference point), positive if it produces tension.

Vzd shear force perpendicular to the defined centre line (depends on the reference point).

Myd moment transmitted about the y-axis; positive, if it produces tension on the bottom side

of the section.

T-joint to verify the shear field, you must enter the internal forces acting in the column in
addition — see Actions - General.

Knee joint  to verify a bolted connection as per DSTV, if such a connection was defined, you must
enter the associated internal forces in the "Actions - General" dialog.
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Welded Beam-to-Column Connection

Actions - General

The design values of the actions (subscript d) must be entered. They can be referenced to the points

shown in the illustration below.

T-joint internal forces in the column top apply in point A or E, internal forces in the beam act in
one of the points A to D.
Knee joint  internal forces applying to the frame joint act in one of the points A to D.
load (001)

right [beam])

-B0.00 kM reference center

Ved= G000 kN Myd= 100,00 kNm

Ve[ 000 KN o[ 0.00] i

top [column)

kM reference center

Ved= 25.00 kN tyd= 30,00 kNm

Upds[  000[ kM Mzo=[  0.00] kNm

N

internal forces 1) [ Add ] I See ] I oK ] I Cancel

)

The reference points are defined as follows:

A intersection of the column centre line with the beam centre line - without haunch

B intersection of the beam contact face to the column with the beam centre line — without

haunch

intersection of the column centre line with the beam centre line - with haunch

intersection of the beam contact face to the column with the beam centre line — with

haunch

E intersection of the column centre line with the contact face of the shear field on top

Note: "Beam centre line incl. haunch" refers to the angle bisector of the haunch outline.

Knee joint  in the "Beam above column" variant, the role of the beam and the column are reversed.
The haunch refers to the column in this case. Optionally, the internal forces can refer
either to the column or the beam.

Nd axial force transmitted in the direction of the defined centre line (depends on the
reference point), positive if it produces tension.

Vzd shear force perpendicular to the defined centre line (depends on the reference point).

Myd moment transmitted about y.

Sign convention:
positive internal forces.

see the illustration in the "Actions - General" dialog showing the symbols of the

Page 6

Software for structural calculation and design



ST14

FRILO

////\\\\

List of internal forces

Geometry

Selecting/editing a cross section

The buttons "Column section" and "Beam section" allow you to
access the dialog for the selection or definition of the
corresponding cross section.

You can define cross sections by specifying their dimensions or by
selecting them from a list of standard steel shapes.
Available are double-T sections as per DIN and a series of special
double-T sections make ARBED.

See also the document Selecting/Defining Cross Sections

In the lower area of the dialog, the current number of the given combinations of internal forces is
indicated in brackets.

Click on the "Add" button to insert the currently defined internal force immediately into the list.

To perform any kind of operations referring to internal forces (calculate, search maximum value,
delete), you can access the list via the "View" button.

geomety

caolumn section

beam section

beam above column

HE 3004
HE 3004

beam jncline = 0

+

=

haunch/mating j.

corher stiffening with flange # joint

tension plate

!

shear field

bz= mm aweb = 30 mm
— weld seam beam-column
afl= 4,0 mm aweb = 4,0 mm

ho strengthening

Select/change the form of cross-section X
F3: Goto tree ) .
Dimensions [mm]
- 1 -F+L cross section database
-1 MName 1290 (=d)
~IPE Height = 290,0
-HE-A
-HEB Width b = 300,0
“HEH Web s = 8,5
(=3 - Dimensions steel Flange E = 14,0
[ 1 - Double-T Radius 7 = 2?10
Results [cm4jom2cm3]
Iy = 182563,50 A = 112,53 Wyt =  1259,55
Iz =  6309,56 Agy = 70,00 Wyb =  1259,55
Iyz= 0,00 Agz = 24,54 wd = 420,64
It = 85,57 ATy = 55,11 Wz = 420,64
ATz = 22,45 Wt = 51,12
R [ ][ wwe 7] (o ) [ oo
Show all cross section values ]

FRILO Software GmbH
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Welded Beam-to-Column Connection

Geometry - T-joint

Beam inclination 3

Haunches top/bottom

Knee Connection

angle between the centre line of the beam
section and the horizontal line in degrees.

accesses the dialog for the definition of
haunches or joint braces. A haunch can be
defined with a cranked chord or, in
addition, with a continuous chord in the
beam in the sense of a joint bracing. You
can define additional stiffeners in the
beam member at the chord end to ensure
resistance against deflection forces.

connection beam-column

1 no stiffening
@) cormer gtiffening with flange

1 znapped off flange

[7] meglect bearn fange

1 hone ztiffening
@ caorner stiffening with flange

1 znapped off flange

[T nealect beam flange

ztiffening delete

stiffening

stiffening bottom

] symmetric

top

2000
h= 2000

2000 mm
h= 2000 mm

geometiy
eaons
beam incline B = oo -

haunches top / bott,

ztiffening top : cormer gtiffening with flange

zhiffening battam : cormer stiffening with flange

weld thickness

aF= L aS5= 4.0 rmm

Tibs bop bearn / stiffening

ribs battom beam / stiffening

zhear field no strengthening

Cancel

For "symmetrica

Weld seam thickness sp
aF
as

Note:

ecifications

versions, the data entry fields for the bottom haunch are disabled.

thickness of the weld seam at the chords of the beam

thickness of the weld seam in the web area of the beam

Depending on your settings, the data entry fields for aF and a$S could be disabled — for

automatic design, the weld seam thickness values are set by the software.

Stiffeners on top

— see the chapter Stiffeners.

Stiffeners on top

— see the chapter Stiffeners.

Note: A braced connectio
Shear field

Utilization

n is assumed.

column bracing by rib stiffeners at the upper beam flange

column bracing by rib stiffeners at the lower beam flange

bracing of the shear field — see the chapter Shear field.

When you activate the 'Calculate' option in the Main menu or the Edit menu, the various utilizations n
are calculated for the structural system in the current state. This might be required after changes of the
defined system or the definition of a new system.

Areas where n > 1 are col

our marked in the system graph.

Page 8
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Geometry - knee joint

Beam inclination

Beam over column

Haunch/field joint

Tension plate

bz
tz
a,web

a,chord

angle between the centre line of the beam geometry
section and the horizontal line in degrees. column section HE 3004,

select this option if the beam should run heam section HE 200,
above the column. In this case, the relation

between the haunch and the member is
inverted. The changed reference points of Wauntingi. commer stitfening with flange / joint
the internal forces shall be considered as
well. The latters can optionally apply either
to the beam or to the column.

[] beam above colurn beam jncline = 00

[ tension plate

lz= 0.0) mnn tz= 0.0{ rmrm

bz= 0.0] mm aweb = 30 mm

accesses the dialog for the definition of a
haunch or a field joint as a screwed
connection as per DSTV (German Steel alfl= 40 mm aweb= 40 mm
Construction Association). In the current

software version, the field joint option is . sliffening

not available for the "Beam-over-column"

connection. shear field na strengthening

activate this option to provide a connection

with a bolted or welded tension plate. The required data-entry fields are
enabled, when you activate this option. Otherwise, the top chord runs over the
connected section and is welded to the web of the latter (a,web).

weld seam beam-column

length of the welded-on tension plate

width of the welded-on tension plate (max. width it that of the section)
thickness of the welded-on tension plate

thickness of the weld seam on the web of the connected steel section

thickness of the weld seam on the chord along the steel section with the
welded-on tension plate.

Beam-to-column connection

a,chords
a,web

Note:

Note:

Stiffeners

Shear field

thickness of the weld seams at the chords of the beam
thickness of the weld seam in the web area of the beam

In the beam-over-column variant, the weld seams refer to the chords and the
web of the column.

Depending on your settings, the data-entry fields for a,chords and a,web could
be disabled. In automatic design, the weld seam thicknesses are set be the
software.

this button accesses the dialog for the definition of column braces by rib
stiffeners at the lower beam flange.

Note: a braced connection is assumed.

In the beam-over-column variant, a beam bracing at the right column flange is
assumed in this case.

bracing of the shear field

FRILO Software GmbH
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Haunch / field joint

A haunch can be defined with a cranked chord or, in addition, with a continuous chord in the sense of a
joint bracing.

You can define additional stiffeners at the chord end to ensure resistance against deflection forces. If a
field joint is immediately at the chord end, no stiffeners are defined there. The deflection forces are
borne by the end plate in this case. You should observe the constructive minimum distance of such a
stiffener from the field joint. Otherwise, it may happen, that the software deletes the stiffener
automatically after checking the geometry!

Welded Beam-to-Column Connection

Knee Connectiocn

stiffening bottom
") none stiffening |= /00 mm
@ cormner stiffening with flange
" shapped off flange h= 250.0imm
[ meglect beam Harge
Mounting joint  EN 1993 j|:
analyzis : ep= 5000 mm
[Components Method) bp= 3000 mm m
connection model : ExP= 2007 il
(V] flush [ Four row hp= 330,0| mm
weld seam
aF= 2.0 mm a5= 2.0 mm |
bualt geometmy M 16-10.9HR
size= M'IEiv dL= 17.0 mm
al= 0.0} mm az= 450 mm
wi= 350 mm wa= 0.0 mm

gliffening delete oK I l Cancel

Field joint as per EN 1993 or DSTV (DIN 18800)

Activate this option to define a knee joint variant with a screwed field joint.

Calculation method EN 1993
In accordance with the component method with two or four vertical bolt
rows. Various calculation options are available in the "Settings" menu.
— See also Steel connections — Component method.pdf

DSTV

- In accordance with the former DSTV Guidelines (1984) with S253, bolts HV
10.9 and two or four vertical bolt rows

- In accordance with the more recent DSTV Guidelines (2000) with S235 or
S355, bolts HV 8.8 or 10.9 and two vertical bolt rows exclusively. The
calculation is based on the simplified method without consideration of the
bracing effect of the beam web in the verification of the end plate in
bending (EPB).

Flush end plate flush to the surface or projecting on top.

Four rows Selection between two or four vertical bolt rows.

Page 10
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ep distance of the end plate (outer edge of beam to beam splice in length direction).

ep cannot be smaller than the (bracing) haunch length.

tp thickness of the end plate.

bp width of the end plate.

pp projection of the end plate on bottom, in combination with the "flush" connection type
also on top. pp can also be negative, max. negative value is equal to the thickness of the
chord.

hp height of the end plate; only enabled, if the "projecting" variant was selected.

aF weld seam thickness at the flanges.

as weld seam thickness in the web area.

Note: Depending on your settings, the data-entry fields for "a,chords" and "a,web" may be

disabled. In automatic design, the weld seam thickness values are set by the software.

Bolts

Size select the desired bolt size from the list. After you have made your selection, the software
proposes a new bolt pattern. In addition, an end plate thickness appropriate for the bolt
diameter is proposed, if the calculation is done in accordance with the old DSTV
Guidelines.

accesses the definition dialog for the bolt details.

dL hole diameter, depends on the selected bolt type and size.

Bolt spacing in the direction of the beam web

al distance of the bolt in the projection to the outer edge of the beam, only enabled if a
projecting end plate was defined.

a2 distance of the inner bolt to the outer edge of the beam.

Bolt spacing in the direction of the beam chords
w2 distance of the bolts to the edges.

w3 inner spacing of the bolts on an end plate with four rows.

Each value that you enter is checked for plausibility in regard to the following conditions:
- The permissible minimum bolt spacing must be complied with.
- The total of all bolt distances must be equal to the corresponding plate dimension.

- When defining dL, an internal hole clearance of 0.3 to 2.0 mm for raw bolts and of 0.0 to 0.3 mm for
fit bolts should be considered.

FRILO Software GmbH Page 11
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Stiffeners

The illustration shows the stiffener dimensions as they are used in the software, t =
stiffener thickness. A short description of each data-entry fields is displayed in the
status line (on bottom left).

=1

Continuous stiffener when you check this option, a three-sided
stiffener connection is generated, i. e. the

ji[: ’I
stiffener length h is equal to the clear distance of h

the flanges.
Take over flange thickness check this option if the stiffener thickness t £ L 4'
should be matched to the flange thickness of the connected section.
Stiffener width b must not exceed the width of the corresponding flange of the
section.
Delete stiffener deletes the dimensions of the current stiffener. Attention: depending

on the prerequisites of the verification, the software adds stiffener
parameters automatically!

Shear field

Select the corresponding option to reinforce the shear field either with a web plate on one side or
diagonal stiffeners on both sides.

shear field input

web plate stiffening

thickness t= 0.0 rmm m

weld A= 30 mm |H

i

[ diagonal stiff. double-s.

thickness t= 0.0] mm

wtidth b= 0.0]

'3 ] [ Cancel

Web reinforcing plate
Thickness t thickness of the web plate
Weld seam aw thickness of weld seam at the web plate
Diagonal bracing on both sides
Thickness t thickness of the stiffener
Width b width of a diagonal stiffener (analogous to the rib stiffener)

To delete a bracing, just untick the corresponding checkbox.

Page 12 Software for structural calculation and design
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Bolt details

Haunch/field joint » Bolt geometry bolt:
The bolt sizes M12 to M36 are available for selection in the strength size strenght
classes 4.6 to 10.9. You can distinguish between raw bolts and fit bolts. 1 :
An internal hole clearance of 0.3 to 2.0 mm for raw bolts and of 0.0 to ﬁ %g
0.3 mm for fit bolts can be defined. H 24
L . . M 27 _

You can select whether the joints of a connection shall all be assumed in H 30 @) black balt
the bolt shafts or the bolt threads. ! () fit bolt
In the joint as per DSTV, only pre-loaded bolts are used. The older DSTV @) shark in shear joint
Guidelines (1984) only permit HV 10.9 whereas the more recent DSTV (7 thread in shear joint
Guidelines (2000) allow HV 8.8 in addition.

A X A planed pre-stressed
After having entered the bolt type, the hole diameter is set to the regular e o
hole diameter of the corresponding bolt size. It can be edited and adjusted SR e
within the permitted range in the dialog associated to the bolt pattern. [ ok l ’ Cancel

The regular hole diameter of M16, for instance, is 17 mm for raw bolts
(internal hole clearance of 1.0 mm) and 17 mm for fit bolts (internal hole clearance of 0.0 mm).

Friction-grip joints are not available.

FRILO Software GmbH Page 13
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Welded Beam-to-Column Connection

Calculate / utilization

When you activate the 'Calculate' option in the Main menu or the Edit menu, utilization ratio

the various utilizations n are calculated for structural system in the current ) GIEEELIS U G R

state. This might be required after changes of the defined system or the m tens plate = 2,24 weld seam from N+

definition of a new system. Areas where n > 1 are colour marked in the system n shearfield= 0.28

graph. n bz = 0.39 Stffeners required!
n mounting . = 1,000 weld seam fram M+

Verification options - settings

To adjust the verification parameters, click on the "Settings"
item in the Main menu.

Any changes to the settings in this dialog have an immediate
effect on the defined frame joint. When you set up a new
item, the software goes back to the default settings,
however. In order to set user-defined values as defaults,
activate the button "As default".

Propose req. minimum thickness of weld seams

Set this option if the software shall propose the thickness of
all weld seams automatically. In this case, all data-entry fields
referring to the thickness of weld seams are disabled and
filled automatically with the appropriate values after each
calculation run. The lower limit for the weld seam thickness
is 2 mm.

Check the constructive limits of the weld seam thickness

options FL5t14

Computation

[7] mew calculation after each modification
[ req. minimurn thickness of the weld seams offer

check the constructive limit values of we{,}thicknesses

additional tengion check for flange below tension plate

[T EC: weld seam beam - column full resistant designed

[T EC: add. werification shear field acc. to Petersen

[ Ok ] [ Cancel l ’ az bazic configuration

Only available in combination with the previous option. When you tick this option, the software checks
the proposed weld seam thickness values against the constructive weld seam limits and the thickness of

the connected components.

Additional tension check for the flange below the tension plate

Specifies whether in the K-joint system with welded-on tension plate an additional simplified verification
of the support flange below the tension plate is performed as a tension bar.

EN: Weld seam between beam and column full resistant designed

Only for calculation according to EN 1993: Determines whether the weld between the beam and the
column is proofed in such a way that it can absorb the limit load capacity of the connected beam.

add. verification shear field The shear field is additionally and independently of the modeled

transmission parameter B proofed by the Petersen method.

EN: optional proof shear field according to Petersen

Only for calculation according to EN 1993: determines whether the shear field is additionally proofed by

the method according to Petersen.

Page 14
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List of internal forces

The list of internal forces allows you to handle any number of combinations of internal forces for the
defined structural system in a table.

Click on the icon associated to the list of internal forces or the "Display" button in the
Actions - General dialog.

Sort

By clicking on the column title, you can sort each column in ascending or descending order.

Apply criteria to the listing

The options below the table allow you to set filters for the rows to be displayed.
The following options are available to filter the entries shown in the list:

- all combinations of internal forces

- all combinations of internal forces with a utilization of more than 100 %

- all combinations of internal forces with a maximum utilization between user-defined limits (in per
cent). Maximum utilization in this context means the maximum loading rate from all verifications. To
display all sections with a utilization rate greater than the specified lower limit, enter 0.0 for the upper
limit.

Delete
Clicking on the "Delete" button deletes the currently selected combinations of internal forces.

Pressing the Shift or Ctrl key while selecting rows allows you to select several combinations of internal
forces at a time.

Output

Click on the "Output" button to display the results of the selected combinations of internal forces on the
screen. You can use the multi-selection feature to group the sections to be put out.

If you make no further selections, the combination of internal forces in the currently active (high-
lighted) row is put out - not to be confused with the combination of internal forces entered in system
definition section!

The number(s) of the combination(s) of internal forces is/are added to the output.

Edit

Click on the "Edit" button to access the dialog of the table of internal forces. You can add new
combinations of internal forces or edit the existing ones.

Calculation

Activating the "Calculate" option launches the recalculation for all cross sections.

Transfer to structural system

Double-click on a combination of internal forces in the table or activate the "Add to the system" button
to take over the selected internal forces in the definition dialog.

FRILO Software GmbH Page 15
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Welded Beam-to-Column Connection

Table of internal forces

In this dialog, you can edit the defined combinations of internal forces in the table and add additional
ones.

The available table columns (internal forces) depend on the defined structural system.

Explanations of the parameters to define are given in the "Actions - General" dialog of the T-joint and
the knee joint.

Note: Some data entry fields offer selection lists. Click on ™ to expand the corresponding list.
internal force list - input table |ﬂ|
number internal force combination  [2] EL.: g"': }* b 4 | .:'ﬁl: ﬁ
Componen , . Nd Myd vza  Componen o Nd Myd Vzd

t
2 Beam | 4] El -50,00 | -100,00 | 50,00 | 3: DSTV A -50,00 -50,00 25,00
2: Beam 4 |zy=tem line column - system line beam } | 3: DSTV A -50,00 -50,00 25,00
B section beam - system line beam k
———  C zystem line column - system line haunch beam
D section beam - system line haunch beam

LI R PR X R
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Output

Output of the system data, results and graphical representations on the screen or the printer.

The Output item in the Main menu allows you to start the output on a printer or the screen.

Output profile
Word

Screen
Printer

Print Preview

Output profile

The output profile allows you to define the scope and contents of data to

the dialog offers comprehensive options for the control of the output scope.

the output data are transferred to the text editor MS Word provided that it is
installed on the respective computer. You can edit and format the output data in
MS Word.

displays the values in a text window on the screen
starts the output on the printer

File » Print Preview shows the output as PDF. You can save this PDF as file —
standard pdf-viewer functions are available.

be put out. Only the activated options are considered in the output scope. g sz:;t
Depending on the context of the currently active connection variant, &[] System input
particular options might be disabled. - [El Comment

Brief

Verifications
Shear field

Stiffeners

Tension plate

Bracing

Field joint

Serviceability

Comment

System 2D

System 3D

Settings

Calculate

-5 Output design

-7 Brief

Bl Verification

- Shear field

ribs, load leading-in
[ tension plate
stiffening, flanges
mounting joint
-0 mounting joint serviceability 2

option to include or exclude intermediate results from
the output (uncheck the option to obtain intermediate
results).

output of the shear field resistance verifications.

----- [ Comment
output of the stiffener resistance verifications as well | [ system drawing 3D
. . . . S System drawing 2D
as the verifications concerning the load application. Er-E3 output
output of the verifications in the tension plate, if | { Word
applicable. % g::;:

output of the verifications in the (haunch) bracing area Ha *’-'bﬁm?ﬁ“d&
as well as of the verifications in the chords due to 5] Bolted ST10

partial internal forces. 4 I :

output of the verification of the field joint, if applicable.

only in combination with a field joint as DSTV-connection in accordance with the
older DSTV Guidelines (1984, DIN 18800).

Your comments on the system.

two-dimensional representation of the frame joint with details (dimensions and/or
legends).

three-dimensional front view of the frame joint in isometric mode.
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Direct transfer to ST10 — Bolted Beam-to-Column Connection

You can transfer the defined structural system to the ST10 application for further processing as a bolted
connection. The internal forces combination of the system definition is transferred and converted to the
reference point A, if required.

To do this, activate the corresponding menu item in the Main menu (sub-item of "Alternative") or the
option "Bolted ST10" in the "Edit" menu.

Application-specific icons

In addition to the standard icons, each application program offers application-specific functions via
additional icons and tool bars.

=ols4p aa@aell— [«

List of internal forces

Connection in 3-d
Hide/display dimension lines

Hide/display legends

(€] [ [£] &)

Hide/display internal forces
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